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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

CAUTION  
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken. 

 

CAUTION  
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken. 

 

NOTICE  
indicates that an unintended result or situation can occur if the corresponding information is not taken into 
account. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation for the specific task, in particular its warning notices and 
safety instructions. Qualified personnel are those who, based on their training and experience, are capable of 
identifying risks and avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

WARNING  
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be adhered to. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this 
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the 
owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 

 

 Siemens AG 
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Postfach 48 48 
90026 NÜRNBERG 
GERMANY 

 order number: 6SL3097-4AG00-0BP0  
Ⓟ 05/2010 

Copyright © Siemens AG 2010. 
Technical data subject to change



 

Getting Started 
Getting Started, 11/2009, 6SL3097-4AG00-0BP0 5 

Preface 

Purpose of the document 

Purpose of this document 
This documentation is aimed at beginners who want to find out more about the 
SINAMICS S120 drive system. The document offers a brief guide to commissioning a 
sample project with a simple SINAMICS S120 drive train. By following the instructions in this 
document, a beginner will need only a few minutes to engineer and configure the sample 
project and start up the motor.  

Technical Support 

Internet address for SINAMICS 
http://www.siemens.com/sinamics. 

EC Declaration of Conformity 

EC Declaration of Conformity 
The EC Declaration of Conformity can be found at: 
● http://support.automation.siemens.com 

– for the EMC Directive under the Product/Order No. 15257461 
– for the Low-Voltage Directive under the Product/Order No. 22383669 

● The relevant Siemens office of the I DT MC Business Unit of Siemens AG 
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Safety notices 
 

DANGER  
 Commissioning is absolutely prohibited until it has been completely ensured that the 

machine, in which the components described here are to be installed, is in full 
compliance with the provisions of the EC Machinery Directive. 

 SINAMICS devices and AC motors must only be commissioned by suitably qualified 
personnel. 

 The personnel must take into account the information provided in the technical customer 
documentation for the product, and be familiar with and follow the specified danger and 
warning notices. 

 When electrical equipment and motors are operated, the electrical circuits automatically 
conduct a dangerous voltage. 

 When the machine or system is operated, hazardous axis movements can occur. 
 All of the work carried-out on the electrical machine or system must be carried-out with it 

in a no-voltage condition. 
 SINAMICS devices with three-phase motors must only be connected to the power 

supply via an AC-DC residual-current-operated device with selective switching once 
verification has been provided that the SINAMICS device is compatible with the 
residual-current-operated device in accordance with IEC 61800-5-1, Section 5.2.11.2. 

 

 
 

WARNING  
 The successful and safe operation of this equipment and motors is dependent on 

correct transport, proper storage, installation and mounting as well as careful operator 
control, service and maintenance. 

 For special versions of the drive units and motors, information and data in the Catalogs 
and quotations additionally apply. 

 In addition to the danger and warning information provided in the technical customer 
documentation, the applicable national, local, and plant-specific regulations and 
requirements must be taken into account. 

 Only protective extra-low voltages (PELV, DVC-A) that comply with EN 60204-1:2006 
can be connected to the connections and terminals between 0 V and 48 V. 

 

 
 

CAUTION  
 The motors can have surface temperatures of over +80 °C. 
 This is the reason that temperature-sensitive components, e.g. cables or electronic 

components may neither be in contact nor be attached to the motor. 
 When attaching the connecting cables, you must ensure that: 

– they are not damaged 
– they are not under tension 
– they cannot come into contact with any rotating parts 
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CAUTION  
 As part of routine tests, SINAMICS devices are subject to a voltage test in accordance 

with EN 61800-5-1. Before the voltage test is performed on the electrical equipment of 
industrial machines to EN 60204-1:2006, Section 18.4, all connectors of SINAMICS 
equipment must be disconnected/unplugged to prevent the equipment from being 
damaged. 

 Motors should be connected-up according to the circuit diagram provided. otherwise 
they can be destroyed. 

 

 
 

 Note 
When operated in dry areas, SINAMICS devices with three-phase motors conform to the 
Low-Voltage Directive 2006/95/EC. 
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SINAMICS S120 drive system 1
1.1 Overview 

This manual provides instructions on how to commission a simple SINAMICS S120 drive 
train based on a sample project. By way of introduction, this chapter of the manual gives you 
a brief overview of the SINAMICS S120 drive system. 
It describes the following steps required to create a sample project: 
 
Step Action 
1 Definition of requirements 
2 Establishment of communication between the PG/PC and Control Unit 
3 Creation of the sample project with the help of a Wizard 
4 Automatic configuration of the sample project 
5 Operation of the PG/PC control panel for driving the motor 

 

1.2 SINAMICS S120 system overview 
The SINAMICS S120 drive system consists of a variety of different modules. It is constructed 
of infeeds, filters, motor power units, modules for additional functions, Control Units plus 
standard and special versions of rotating and linear motors.  
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Requirements 2
2.1 Hardware and software components 

● A CU320-2 DP Control Unit, firmware version 4.3 SP1 or higher, with integrated 
PROFIBUS interface 

● A Line Module 
● A line filter 
● A Motor Module 
● A motor with built-on encoder evaluation unit with DRIVE-CLiQ interface (SMI motor) 
● A standard PC with Windows XP as programming device (PG/PC), with pre-installed 

STARTER commissioning tool (firmware version 4.1.5 HF5 or higher) 
● Motor and power cables 
● DRIVE-CLiQ cables 
● PROFIBUS interface CP5511 installed in the PG/PC 
● PROFIBUS connection between the PG/PC and the Control Unit 



Requirements  
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2.2 Wiring the components 
The assembly and wiring of components according to the sample project depicted below 
must always be undertaken by qualified specialists. For the purpose of commissioning this 
sample project, it is not permissible to connect other components or drive loads to the motor. 

 
 

 Note 
For information about assembling and wiring the components of the sample project, please 
refer to the relevant chapters in the SINAMICS S120 Equipment Manual GH2.  
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Creating a drive project 3
 

This chapter explains how to create a new drive project. You set up a sample project using 
the STARTER commissioning tool. You then transfer the sample project to the Control Unit 
of the real drive over a communications interface. 
PROFIBUS has been selected as the data exchange system between the programming 
device (PG/PC) and the Control Unit (CU).  

3.1 Setting the communications interface 
1. Double-click on the icon to launch the STARTER commissioning tool: 

 
The main window of the STARTER application is displayed. 

2. Click on menu command Options > Set PG/PC Interface. 
The "Set PG/PC Interface" window opens: 
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3. In the dropdown list "Access Point of the Application", select entry 
"DRIVES (STARTER, SCOUT) --> CP5511(PROFIBUS)". 

4. Click on button "Properties" in order to set the interface. 
The "Properties - CP5511(PROFIBUS)" window opens as well. 

 
5. Set the address to "0". 

A data transmission rate of 1.5 Mbit/s or above is recommended. 
6. Click on "OK". 

The "Properties" window closes.  
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7. Click on button "Diagnosis" in the "Set PG/PC interface" window. 
The diagnosis window opens as well. Check the function and settings of the interface in 
this window.  

8. Click on button "Test". 
The status of the PROFIBUS interface is displayed. 

9. Click on "Read". 
The status of the connected stations is displayed according to the legend.  

 
10. Click on "OK" in order to close the diagnosis window. 
11. Click on "OK" to exit from the "Set PG/PC interface" window. 
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3.2 Creating a new drive project 
The project wizard will guide you through all the steps necessary to create and set up a new 
drive project. 

Sequence 
1. Click on menu option Project > New with Wizard. 

The main screen (Introduction) of the project wizard is displayed. 
2. Click on button "Find drive units online...". 

The project wizard continues to step 1 "Create new project". 
3. Enter a name for your project, e.g. "Sample Project", in the project name field. 

 
4. Click on "Continue >". 

The project wizard continues to step 2 "PG/PC - Set interface". 
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5. Click on "Continue >". 
The project wizard continues to step 3 to search for drive units. The drive units found are 
displayed in the preview box. 

 
6. Select the drive unit "S120_CU320_2_DP". 
7. Click on "Continue >". 

The project wizard continues to step 4 to display a summary of your project settings. 
8. Click on button "Complete". 

The project wizard closes the window. The project navigator opens and lists the detected 
drive unit under the sample project.  
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Configuring your drive project 4
4.1 Restoring the factory settings 

In order to restore the drive to a defined state, it is recommended that you reset the drive 
parameters to their "factory settings" or defaults before the drive is commissioned. 

Sequence 
1. Select the menu command Project > Connect to target system. 

The window "Target Device Selection" opens and displays a list of the detected drive 
units.  

2. Activate the check box " S120_CU320_2_DP " and click on "OK". 

 
 

 
The PG/PC establishes the link to the Control Unit. It then performs an "Online/offline 
comparison". The result is displayed in a window. 

3. Click on the "Close" button in the results window. 
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4. Select drive object S120_CU320_2_DP with the right-hand mouse button and select 
command Target device > Restore factory settings in the context menu. 

 
5. Click on "OK" to confirm the prompt. 

The PG/PC sets the drive parameters to their factory settings. The new status is 
transferred to the memory card of the CU320_2_DP Control Unit.  
The factory settings are now restored and the drive is in a defined state.  
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4.2 Configuring the drive units 
In this chapter, a link is established between the connected drive unit and the 
S120_CU320_2_DP, and the drive unit is configured for operation. 

Sequence 
1. In the project navigator, click on the "+" symbol before the entry "S120_CU320_2_DP". 

A list of the drive units in this drive train is displayed. 

 
2. Double-click on option "Automatic configuration" in the project navigator. 

The following information window is displayed: 

 
3. Click on button "Configure". 
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The Control Unit searches for connected drive units over the DRIVE-CLiQ interface and 
finds a drive in the sample project. 

 
4. Select the entry "Servo" from the dropdown list "Default setting for all components". 

The drive in the sample project will now be controlled as a servo drive. 
5. Click on button "Create". 

The automatic configuration process commences. When the process is complete, the 
window "Automatic configuration completed" is displayed. 

6. To continue configuration, click on button "Go OFFLINE". 
7. In order to select the line filter, double-click on option "Infeeds > Infeed_1 > Configuration" 

in the project navigator. 
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The window for infeed configuring is displayed: 

 
8. Click on button "Wizard..." 

The window "Configuration - S120_CU320_2_DP - infeed drive object" is displayed. 
9. Click "Continue >". 

The window "Configuration - S120_CU320_2_DP - infeed drive object - additional data" is 
displayed. 

10. In the dropdown list under the check box "Line filter available", select option "[1] 
Wideband Line Filter ...". 

 
11. Click "Continue >". 

The window "Configuration - S120_CU320_2_DP - process data exchange ..." is 
displayed.  
Note: 
Don't change anything! 
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12. Click on "Continue >". 
The summary view opens.  

13. Click "Complete". 
You will now exit the wizard. 

14. In order to transfer the manually changed data to the drive system, select menu 
command Target system > Download > Project to target system. 
The data are copied to the Control Unit.  
You have now completed configuring the infeed.  

4.3 Configuring the Motor Module 
The Control Unit has detected the connected Motor Module and the SMI motor during the 
automatic configuration process. The device data have been transferred to the Control Unit. 
The Control Unit has automatically entered the correct device data into the parameters 
required to operate the components. 
The sample project is now ready to commission.  
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Commissioning a drive 5
 

Control panel functions 
The control panel allows you to perform basic tasks for operating, monitoring, and testing the 
drive. Virtual START/STOP and JOG keys are provided for operation of the drive, along with 
various diagnostic functions.  

References 
For more information about these functions, refer to the SINAMICS S120 Function Manual. 

Operation with the virtual control panel 
1. Double-click on option 

"S120_CU320_2_DP > Drives > Servo_03 > Commissioning > Control Panel" in the 
project navigator: 
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The control panel window is displayed. 

 
2. Click on button "Assume control priority". 

The "Assume control priority" window opens in addition. 

 
3. Click on button "Safety notes". 
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Another window containing the safety notes is displayed. 

 
4. Read the notes and then close the window by clicking on the "Close" button. 
5. In the "Assume control priority" window, click on button "Accept". 

The window is closed and the control panel is activated. 
6. Click on button "LM" (Line Module). 

 
The infeed charges the DC link. A window with progress bar indicates the charging 
status. The drive is enabled as soon as the DC link is fully charged. The check box 
"Enables" then becomes available for selection. 

7. Activate the check box "Enable signals". 

 
Buttons "I" and "0" become available for selection.  
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8. Enter a suitable speed for the motor in input field "n = ", e.g. 1000. 

 
9. Click on button "I". 

 
The motor accelerates to the selected example speed, i.e. to 1000 rpm. 

10. To shut the motor down, click on the "0" button or hit the space bar on the keyboard. 
The drive coasts to a standstill. 

11. By clicking on button "Give up control priority !", you relinquish control priority. 
12. By selecting menu command Project > Disconnect from target system, you sever the 

communication link between the PG/PC and the Control Unit. 
13. Save the sample project to the local hard disk of the PG/PC by selecting menu command 

Project > Save. 
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